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Harper College  
Workshop for Designers 

The rules and techniques covered in this workshop will 
be of little purpose unless they are gradually incorporated 
by the designer. It would be impractical to use all these 
techniques immediately. Therefore, as in any New Year’s 
call to action, you could make a resolution to put forth 
the effort to incorporate better layout features in your 
workflow slowly. This might also be advantageous when 
moving a Quark document to an InDesign layout. Examine 
the contents, decide on styles, masters, auto text flow, etc. 
before placing any content. It is your responsibility as a 
designer to develop good design and layout habits.

Incorporating standards requires a very good 
understanding of the established standards in your 
standards manual. If your manual is not well-defined, it 
will be difficult to define them in InDesign. The main idea 
behind this workshop is to explore some ways to employ 
these well-established standards in our layouts. We will 
create a set of styles to import, explore the idea of using 
master pages as standard layouts, explore libraries and 
snippets—perhaps to be stored on the graphics server—
and we will consider the possibility of templates complete 
with master pages, styles, and layout elements ready for  
you to input content.

Alternately this workshop is designed to help you 
streamline your work. We will also discuss the possibilities 
of using grids, understanding the best font formats to use 
and why, setting up your InDesign preferences to help 
you avoid annoying problems, and we will review some 
quick rules of thumb for picking the right complimentary 
typefaces for your layouts. Finally, to make your copy 
readable and editable—and, of course, beautiful—
miscellaneous desktop publishing topics are covered.

To take full advantage of the workshop, you might consider 
communicating with your coworkers to decide the best 
way for you to use these procedures, and determine which 
standards or procedures might work best for your situation. 

Please consult the demo files (in PDF and indd format) 
which accompany this manual. You will be able to review 
and practice the techniques on your own. 

In PDF format, this book should include links to all the 
topics in addition to bookmarks. All copy in the bright blue 
color is a link. Please consult the following links for further 
reading or additional information:

Wikipedia Manual of Style

InDesign User’s Group, Chicago Chapter

InDesign Magazine

Lynda.com–A free week membership enter “Deek” for the 
code. [Deek Mclleland]

http://indesignsecrets.com/–Great reference place. Sign up 
for the podcast.

http://www.nobledesktop.com/shortcuts.html – Keyboard 
shortcuts for many applications

We learn more by looking 
for the answer to a ques-
tion and not finding it than 
we do from learning the 
answer itself.

—Lloyd Alexander

Simplicity is about subtract-
ing the obvious, and adding 
the meaningful.

—John Maeda

http://en.wikipedia.org/wiki/Wikipedia:Manual_of_Style 
http://www.indesignusergroup.com/chapters/chicago/
http://www.indesignmag.com/
http://www.lynda.com
http://indesignsecrets.com/
http://www.nobledesktop.com/shortcuts.html
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Setting up preferences 
A quick run-through of some very simple preference 
settings will answer questions before you can ask them. 
Close all documents, to set up preferences which, once 
saved, will apply to all new documents.

Absolute numbering If you are creating page 
sections in your document, you will need to specify the 
sections exactly as they are named to print certain pages. 
If you set the page numbering to absolute, you can merely 
specify the page numbers as they appear in the panel. 

Adjust Scaling Percentage When you use the 
select tool and scale a text box, it will retain its original type 
size information, and you will see this in parentheses after 
the type size in the control panel field. Unless you need to 
know the original size of the type before you scaled it, in the 
prefs., click the radio button “apply to content.” This feature 
applies to an object (you scaled an object, not text). If you 
open a document with this issue, with the select tool, select 
the text frame, and from the flyout dropdown choose  
“Scale Text Attributes.”

Type Under “type” in the preferences, it is best to check 
all of the first section options. The “apply leading to entire 
paragraph” is important so that last line of a paragraph 
won’t be different from the rest of the lines. A reason to not 
have this feature checked is when part of your paragraph is 
using all caps and you will need to adjust the leading in that 
line only. “Drag n drop” is a feature MS Word has that can 
be handy to use…your call. “Links:” You should not have 
links checked unless this is necessary.

Units and Increments How you set this up can be 
easily changed in the document. If you set your document 

to pica measurements, you can right click in the ruler of 
the document window and change to inches. It is best to 
keep your documents in picas/points to develop good 
habits. Advertising material is generally set to inches.

Spelling It doesn’t hurt to check them all.

Clipboard Handling At the very end of the 
preferences, check the option to import copy as text only, 
and not the styles. If you have your Basic Paragraph style 
set properly, or if you are placing into a text box with the 
style you want already applied to that text box, the imported 
copy should come in with your desired style and not its 
original styles from another application. Remember while 
actually performing a “place text” from another application 
(not InDesign), check the “options” feature. You can choose 
which formatting you want to import (depending on the 
application). With InDesign copy, you should copy/paste.  
If you don’t want the styles to come into your destination 
doc, before copying from the source doc, choose “break  
link to stye” in the paragraph styles panel, while the copy  
is selected.

Text wrap Another preference worth mentioning, is 
the “text wrap” in the Composition category. When you are 
working with an object with text wrapping on either side 
and left justification applied to the copy, the text on the left 
will not but up to the object, and the text to the right of the 
object will. To fix this, set your text wrap to “Justify Text 
Next to an Object.” This only works inside one column, and 
will not full justify. 

Balancing rags Sometimes you will try to make 
soft line breaks in your copy, but InDesign fights you 
and changes all the other line endings and makes a very 
noticeably bad rag. One reason for this is because a  

PREfEREnCES & DEfAulTS
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“Balance Ragged Lines” command is attached to the text. 
The fix for this is to turn it off in the paragraph drop down, 
and choose the single line composer instead of paragraph 
line composer. Also, check to make sure Balance Ragged 
Lines is not a property in your paragraph styles. See “Better 
Rags” in the Afterthoughts section. 

Note about preferences: Preferences saved with a document 
and will override your default prefs. If you create a new 
document, however, your default preferences apply. Check 
the document prefs. for any documents you edit.

Creating and Saving Your Workspace 
If you have developed work habits and you are happy with 
them, you might want to save your personal workspace as 
a choice, so when things get out of hand, you can quickly 
return your desktop to the way you like it. This is also a 
precaution against an inevitable crash, whereby InDesign 
will wipe out your prefs. and reset everything. 

The best way to start is by resetting your workspace  
(Window > Workspace > Default)  Then, you might want  
to add hyperlinks and bookmarks—I find text wrap  
important  CS2 has a less-than-desirable default, so you  
may want to pay more attention to that application  

When you have your workspace set as you like it, 1  
from the main menu window, choose Workspace > 
Save Workspace  When you are ready to reset your 
environment, choose Window > Workspace > and select 
your name (or whatever you named it) 

Note: the tools box preference is set in InDesign’s 
preferences. You may click on the expand arrow to make 
it a double column.

Cmd + k opens 
prefs.

NOTE:

You can set up your own 
shortcuts in the styles, in ad-
dition to setting up shortcuts 
for many other functions you 
may perform often.

To set up a paragraph style:

You must use the number 
keypad, therefore if you have 
a laptop, you must turn on 
the num lock (F6). Short-
cuts are especially great 
for applying italics and bold 
character styles while in a 
paragraph style.

For your panels workspace, you can click on the double 
arrows to expand all the panels. It is a good idea, when 
screen real estate is at a premium, to get comfortable with 
the single panel using icon recognition. 

A preset worth noting, is “new document features” when 
opening a new document. For example, if you want 
consistent document features, you can set up a document 
how you like it i.e., with no facing pages and no margins. 
Save this set up as your default (Save As > [choose] 
Default). Other features of a new document are margins, 
bleeds, Picas/Points, and a slug area. If you don’t care to 
make this a default, or if you want a preset for single pages 
or a preset for spreads, name your preset accordingly.

 



4 Table of contents

  Harper Workshop for Designers – Working with Styles

Responsibly, we need to package our files, move the 
important working files to our computer, and throw away 
the rest. The same function should apply to the document 
itself. There shouldn’t be any unused colors, unused 
styles, unused masters, or text and image boxes in the 
pasteboard. Preflighting and cleaning up your document 
can save someone a lot of headaches as well. What makes 
a design especially nice, is when it can easily be modified 
and the layout can quickly be understood by other 
designers. You should think about who might work on 
your documents in the future and what changes might be 
required. Standardizing and communicating rules for how 
documents are stored is a time-saving feature.

To go a step further, it is good practice to use character, 
paragraph, and object styles consistently. On larger 
documents, especially, applying styles is very necessary—
and not just for consistency of your design—for anyone 
who may need to work with your layout in the future. 
Organizing your styles will help with housekeeping. If 
you think you don't have the time to clean up files and 
folders, styles, colors, etc., you should perhaps re-evaluate 
the organizational process as a standard, whereby you 
determine the time it will take to create a layout which 
includes these steps…standardizing your workflow 
thoughtfully and responsibly.

Setting up styles every time you open a new document is 
unreasonable. However, to have a set of styles well-named 
and with all the necessary properties will enable you to save 
lots of time and not have to reinvent the wheel. Consider 
importing a predefined set of standardized styles when 
you open a new document. For that matter, why not open a 
template with the styles, masters, and basic layout elements 
already in the document? 

WORkIng WITH STylES
Sec 2-1: Default Paragraph Style
Open InDesign, but do not open a document. 

Double click on the "(Basic Paragraph)" style  This is 1  
your opportunity to eliminate “Times” from your layouts  

Choose Helvetica Neue, 45 light, 10 pts , and default 2  
leading  If you want to use a standard "space after or 
before" set that up (approx  6 pts )  If you don’t want 
hyphenation, set that up also  Because Helvetica is very 
“tight,” a tracking value of 15 is nice 

Open a new document, and when you type into a text 3  
box, it will be in the style you created  You will at some 
point have a crash and lose these preferences, so it is a 
good idea to save a document with this default and other 
standard styles assigned to it 

Sec 2-2: Create a Set of Default Styles
Creating a set of styles for standard use or personal use is a 
timesaving advantage in page layout. The directions (below) 
will instruct you in creating paragraph styles incorporating 
character styles. This way, a style override will not appear 
in the paragraph style panel when you want to apply a 
different character style on some text within it. Avoid style 
overrides whenever possible.

Create a copy of the default style, and with this  1  
style highlighted, create a text box and fill it with 
placeholder text  

Highlight some words and apply another style (bold)  2  
Notice the '+' sign in the paragraph styles panel  
indicating a style override  

EYEDROPPER TOOL

You can easily duplicate 
your paragraph, character, 
or object styles while 
working out a design using 
the eyedropper tool. 

Scenario: You have created 
some really awesome copy 
with color, transparency, 
size, style, drop shadow, 
etc. You are not ready to 
set up character styles, 
paragraph styles, etc., as 
you are working out the 
bugs...you don’t want to 
commit. 

So, highlight the copy you 
want to look like the good 
stuff you created, select 
the eyedropper tool, and 
click on the text whose 
style you want to replicate. 

Double click on the 
eyedropper tool to set up 
its preferences before you 
try this. I usually have it set 
to copy everything.

The eyedropper tool also 
comes in handy if you just 
want to copy text only, use 
the setting to only copy the 
text stroke and fill.
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While this “bold” copy is highlighted, create a character 3  
style called "default bold " This way, the paragraph style 
will not consider this an override  

Highlight again and create an italics character style 4  

The “based on” feature:

For fun, create a headline paragraph style (like “H1 HN 1  
LT Std black”) at 20 points 

Create a subhead paragraph style, “H2,” “based on” 2  
the H1 at 14 pts  Based on takes on the attributes of the 
former 

Save your document as "your name default styles" 3  
wherever you keep your personal files 

View the attached file CreatingStandardStyles.pdf for an 
example.

Note: When using “based on” as with master pages 
(later section) updating the original (parent H1) will 
automatically update the child (H2), but only to the extent 
that it can.

Import (Load Styles)
If you are beginning a layout, you may want to import a set 
of default styles or styles from another document. You will 
want to open a new document and load styles.

 From the paragraph styles drop down choose "load all 1  
text styles" (Fig 2 1)

Locate the document with the styles you want and 2  
select it  Check mark "check all" and click "OK " 

If you import the “basic Paragraph,” it will override your 
default, so think about your goal for the project.

Style Shortcuts

Get rid of an override: 
Option+click the style

Apply the override to the 
style: 
Rt. click on the style…rede-
fine style.

Create custom shortcut for 
a style (best for character 
styles): 
You must use the numeric 
keypad in combination with 
one or more of shift, option, 
and/or command

Nested Styles

When creating a paragraph 
style, in the nested area (left 
column) choose a character 
style you want to embed. 
You can assign that charac-
ter style to a certain number 
of words in that paragraph.

Fig 2.1

Fig 2.2

The styles 
loaded into 
your new 
document



6 Table of contents

  Harper Workshop for Designers – Libraries vs Snippets

lIbRARIES VS. SnIPPETS
Libraries can be used as another form of standardizing, a 
less-involved process than creating template documents. 
Libraries can store information in the form of graphics, 
text, objects, or whatever elements you may have in a 
layout. They can store an entire page of elements in their 
exact arrangement for dragging and dropping. I.e., save 
the slogan “it’s time” (along with it’s following message) as 
a library element. It would maintain the size it was when 
dragged into the library. Another example would be the 
various Harper logos in a library (not linked to the original 
file, but saved in the library embedded). This is much better 
than using .eps files also, as .eps files are not recommended 
for any design application. The procedure is to outline 
and object in Illustrator and copy/past into InDesign 
and dragged into a library. Another example for library 
use might be the whole Harper bar, designed to a basic 
standard. This can be dragged onto a document and then 
altered accordingly. 

The difference between the library and the snippet are 
really organizational differences. A library can store all the 
elements which can be viewed as thumbnails or lists. Lists 
are great if the items have been named well. Snippets on the 
other hand, are individual files. The advantage of snippets 
is that they can be viewed in bridge. The snippet can be 
dragged onto a document from bridge or any location—not 
just from the library panel. 

Creating a library
When creating a library from file > new, be careful how you 
name it. This will be an important reference. If you have a 
library for just a particular job only, save it to the job folder 
and perhaps name it with the job number. Note: this will 

not be a packaged item; you will need to manually copy a 
library from one folder to another. 

Choose how you want to view your library  If you use 1  
thumbnails view, choose large thumbnails  It is more 
efficient to set a list view 

If there are certain objects you want in the library, select 2  
them and click the “new” button at the bottom of the 
panel, or drag them into the library  Be sure to name them 
well, and give a good description  

To drag the whole page from the library into the layout 3  
you are currently working in, select the item, click the 
library drop down and add all the elements as one object 
(this will place the collective element in a document in its 
exact former position  You may also click on the element, 
right click, and choose “place ” 

An important thing to know about both libraries and 
snippets is that the items in them will be embedded in the 
library or snippet if they were imbedded in the original 
document. If the original item was linked to a location, the 
library/snippet item location will be linked the same. If the 
original element’s location changes, the link will be broken. 
If a library containing linked elements is moved, the library 
will retain the links for the original, however if the original 
element (to which the library is linked) is moved, the 
library will lose its link. The item will need to be removed 
and replaced into the library.

Libraries become part of your temporary workspace and 
are not linked to a document. If your workspace is reset to 
default or other, you will not see the library in your panel 
icons. Open the library from its stored location and drag it 
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to your panels dock. You may open as many libraries as you 
wish. Save the important libraries to your workspace.

Creating a Snippet
Snippets are a drag-n-drop feature. If you have a large 
monitor, these can make a lot of sense. Snippets are, 
however, individual elements not accumulated and stored 
in one file like a library. These might be good to use if  
you are working on a one-time document for a specific 
project. Again, the same linking rules follow with  
snippets as libraries.

Snippets are impervious to crash problems and do not 
appear on the “recent” menu. A supreme feature of 
snippets could be a server location, subdivided if necessary, 
dedicated to snippets enabling you to see many of them just 
as you view images. You can visually choose the item you 
need, such as a Harper bar, a logo, indicia, a master page, 
graphic objects, etc.

Select the element or elements you want to save and drag 
them to the location you want, i.e., job folder, desktop, 
images folder, designated snippets folder, etc.

If you “place” a snippet it will fall on the page accordingly, 
however if you “place” a library item, InDesign will attempt 
to place it in its original relative position. See the sidebar.

Therefore, if you use libraries or snippets for standardized 
use, located on a shared server, you could maintain a 
database of images and objects which will remain consistent 
and stable.

Drag ’N’ Drop Technology

vs Organization

Snippet Shortcuts

Place a snippet based on its 
original position: 
When dragging a snippet, 
hold down the option key 
and let go of the mouse.

Snippet Preference: 
Set up “original location” for 
the drag and drop snippet 
feature in the “file handling” 
section of InDesign’s  
preferences.
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MASTER PAgES
clicking, holding and dragging the name of the spread to 
the pages panel.

Create any other masters that might be an alternate of 
your original. Use the based on feature if you want to 
retain the original master’s elements. See below.

Sec 4-2: Create a ‘Based on’ Master
You might want to make another master retaining the 
original elements but adding additional elements that could 
be on some of the pages. You can make a new master of a 
single left or right side, also. To do this select "based on," 
when you create a new master. If you base a new master 
on the A-Master, the A-Master’s elements (or any original 
based on page items) will be locked. You can also override 
all or some of the master items (see the sidebar). If you 
do break elements, then they will not update when the 
(based on) A-Master changes. You can undo an override by 
selecting the elements and choosing “Remove all Selected 
Local Overrides” from the panel’s drop down menu.

Right-click in the master page area and select “new 1  
master ” Leave the prefix field as is  Choose based on 
“A-Master” from the drop down and choose one or two 
pages  You may name it whatever you want (short name) 

Add additional elements and remove any unwanted 2  
elements brought in from the A-Master  You can set 
different column guides as well 

Note: To use templates—for example a brochure—the 
column guides, the page numbering, and additional 
elements can be included in the master, along with the styles 
in a document.

Setting up master pages for a long document has its  
obvious advantages. Setting up masters for shorter 
layouts—i.e., brochures, postcards, ads, invitations,  
annual mailers, etc. is also smart if used consistently; 
otherwise, it isn’t practical to set them up for one-time 
short documents. To go a step further, a template with  
styles and master pages is ideal.

To make this practical, we should use master pages 
(habitually) to become comfortable and familiar with their 
features. Planning and understanding what elements will be 
incorporated in your layout before getting started will result 
in time savings and better workflow.

Master Page Basics
Create a document with a spread, setting up margins. You 
will see you have a blank one-page master, and a spread 
A-Master. 

Double click on the words to the left of the image of 1  
the spread  This selects the spread rather than one page  
Option + Cmd 0 will make a spread fit in a window 

Set up any guides, repeating page numbers, objects, 2  
etc: Setting up page numbers or section markers can be 
done by creating a text box in the master, and inserting 
special character > markers > next page (or “section”)  

Set up any columns or grids if you want them here  3  
The advantage is you can adjust the columns and grids to 
inconsistent sizes  This is under layout > create guides  We 
will cover this later 

You now have a master page. You can rename it by double 
clicking on the name. You can drag the spread down by 
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Create Section Headers 
To create a running header, make a text box in the 1  

master where you want the header to run, just as you 
would for auto page numbering  

Click on “Type > Insert Special Character > Markers > 2  
and then Section Marker (Fig 3 1)  

Be sure to drag the text box out to make sure all 3  
your text will fit  Add whatever text you want that will be 
repeated on every page with this marker 

In the pages panel, right click the page that you want 4  
to assign this running header, and choose “Number and 
Section Options ” 

Where the field is labeled “Section Marker” fill in the 5  
area with your desired text (Fig 3 2)

Be sure to set the page number to the correct page number 
in the layout.

Note: When creating sections in a layout, be sure to set 
your preference for “page numbering” to absolute so you 
can print using the page numbers rather than the section 
numbers. 

Create Auto Page Numbering
Recreate the step above, however when you have your text 
box in the master selected, choose “current page number.” 
You should not need to make any further adjustments. The 
page number is set in the “section and numbering,” or it will 
remain automatic. See 3.3. 

Sec 4-3:
Fig 3.1

Fig 3.3

Fig 3.2

Master Page  
Shortcuts

Release all master page 
items: 
Shortcut (context menu): 
option + Cmd + Shift + L

Release one object: 
Shift + Cmd click on object
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gRID uSE
Grids are as complicated as you make them. You can plan 
them out like you create thumbnails. With long documents, 
such as a newsletter or annual report, layouts get more 
challenging, so creating thumbs and developing grids 
merely provide an aid for you to maintain organization 
and consistency in your layout. Creating grids will help 
you focus on determining placement of elements based on 
general principles of design and the flow of the message.

Whether you use grids or not is your call, however, if you 
have layouts which have been standardized, they will be set 
up with all the beneficial elements in tact, the grid being 
most essential.

Numerous masters are also used to provide different grid 
structures that are repeated in the layout. As a designer, you 
need to determine how many grids structures you should 
use: too few and your layout becomes static and predictable; 
too many and your layout creates a barrier to readability 
due to haphazard and inconsistent placement and use of 
elements. Hectic grid use quickly becomes tiring causing 
your reader unnecessary interruptions. It is sometimes 
better to create a static layout that gets read rather than lose 
design credibility. 

Determining a Grid Structure
In determining grid use, begin by understanding your 
target audience. What do they want to see? If they are 
young (perhaps FTIC) then you should try to make the 
layout as entertaining as possible without losing sight of the 
intent. If your layouts are for an audience absorbing a lot 
of information, then a more consistent layout would help 
the flow and assimilation of information. For a younger 
audience, maybe get started on your layout  

visually brainstorming (use the eyedropper tool!). Create 
two or three rough pages, and rethink the structure. This 
structure should give your layout unity, yet at the same 
time, work with your design. For the older audience, it is 
often a better idea to plan out your layout, think it over 
before starting the layout.

Either way, once you have developed a structure, 
substantiate it by saving your page as a master, leaving 
the necessary elements and taking out the variables. Work 
with these masters and your roughs to determine how you 
might use each one, and how to vary them yet maintain a 
consistent look. Appropriate repetition is important.

Sec 5-2: Creating a Grid
Using a grid does not mean merely creating columns when 
you create a new document. A grid can consist of rows as 
well a columns; a grid can have various sizes of columns, 
inadvertently placed. A grid is a useful tool to help create 
the repetition of consistent elements necessary in a good 
design. Therefore, the use of guides, is a way of creating a 
grid in the minimal sense.

There is more than one way to skin a grid. You can use the 
method you like, or the method that is called for in the 
project specs. 

Method One: When creating a new document, choose 
columns. This is the simplest form of a grid (besides 
establishing margins). It is not directly editable in the 
master, however. In your layout, you can choose to stay with 
the columns (generally a 2-column layout) however it is 
much more interesting to span columns (such as in a 4 or 
5 column layout). A general rule, when thinking through 
your grids, is to remember that the width of a column 
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(line measure) should be no more than 13 words long. 
Play around with the typeface and different sizes/measures 
before setting up your grids.

Method Two: To create columns while in a master, 
which are editable, don’t create columns when opening a 
new document. (See below).

Double click on the master  From the top menu under 1  
“layout” select “Create Guides ” You can select columns 
and rows as you please  Note: Base the guides on the 
page rather than the margins, because margins do get 

altered, and the grid is generally visualized by the whole 
page 

Use the select tool to adjust these guides to create 2  
customized columns and rows  You can add or subtract, 
or increase the gutter and alleys  Note: there are 
techniques to make these guides even  

Method Three: creating a structure by dragging guides 
into your layout is creating a grid. These are great when 
creating an initial design. You can copy the guides you made 
in your pages and paste them in a master so you can use the 
same guides for all your pages, or some of your pages.

Method Four: Another way to create columns is directly 
in the text frame, whereby you pick “text frame options” 
from the Object menu, and choose your insets, justification, 
and baseline grid. This is applied only to a particular text 
frame, and is inconsistent, therefore this is best used for 
sidebars or short amounts of information.

Sec 5-3: Breaking a Grid
Breaking a grid is a perfectly natural layout process. It 
relieves the monotony, and can provide a break in thought, 
a bit of entertainment, or some other quality. You want to 
hold your reader, get them through the material, and make 
them feel as though they have benefitted from reading and 
participating in your layout. 

Try to return to the original grid so your audience can get 
moving in your intended flow again. If you break your 
grid again the same way, you are creating an alternate grid. 
The idea of establishing unity without it being obvious is 
difficult however the overall effect will have your reader 
reading and appreciating your more “sophisticated” layout.

Personalized key-
board shortcuts in 
the menus:

Edit > Keyboard Shortcuts. 
Choose the menu you 
want to modify. In the “new 
Shortcut” field, type the 
keys you want to assign to 
a function. For the “Con-
text” choose what context 
(right click) menu you want 
this to appear in beside the 
regular menu. If you want 
to make a few of them as-
sign them. Be sure to make 
a new set and name it. 

Your [shortcuts] set is 
located in the user’s library 
> preferences > InDesign 
> InDesign Shortcuts. The 
file will end with .indk. You 
can copy this to load on 
another computer.
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lOng DOCuMEnTS
Working with long documents, flowing copy can save 
a lot of time, assuming you possess all the copy for the 
publication. There are three basic options for flowing text 
into frames: The first option is to do a manual text flow. It 
will load text into one frame at a time. To link other frames 
you need to click on the “out” port of the first box with 
overset text, and then click the “in” port to continue  
flowing the copy. 

The second way is to semi-auto flow. The cursor is loaded 
with the text, and you can click on the text frames, one after 
the other until all the text is placed. You don’t use ports.

The third way to flow text is to auto flow. By shift clicking 
on the top of the page margin or inside the threaded text 
frame, all the copy will continue to flow auto-generating  
as many pages as necessary until all the text is set. 

Note: There are three documents associated with this 
section. Open them all at the same time (Sec 6 Flowing 
Copy folder).

Manual Text Flow 
You will use the “place” command to import your text. 
Note: To link text to your document, you will need to set up 
“link text” in the preferences.

Either use the shortcut Cmd + d, or File > Place then 1  
locate the document you wish to place  You may choose 
to “view options” which will help you to filter the styles 
you wish to import, or the options allow you to turn off 
importing styles completely 

Select the document to import and you will see a 2  
loaded cursor if you haven’t already placed your cursor 
in the box  

Sec 6-1:

Click at the top of the text box  If you don’t have a text 3  
box, you can click at the top of the margin indicator and 
the text will fit into your designated column or page  

If you have overset text, you will then need to click on 4  
the out port  Once the cursor is loaded again, you may 
click in another text box, top of margin, or drag a text box 
and the copy will flow into it 

Sec 6-2: Semi-Auto Text Flow 
If you are wanting to link your text frames in an unusual 
order in a document this might be a good choice. You 
will place the text, but you must click on the text frames 
sequentially to place the text. You do not need to click on 
the in and out ports.

Follow steps 1 and 2 from the manual text flow  1  
section, but instead of just clicking on the margin (for no 
text frames) or clicking in the text frame for master frames,  
etc , you will option + click  

Your cursor will be loaded, and you won’t need to click 2  
on the ports  Continue to Option + click on the text frames, 
pages you create, or drag a text frame where you want  
Note: You will need to make the pages as they will not 
auto-create 

Sec 6-3: (Full) Auto Text Flow 
This option will create pages automatically. The only 
difference with this feature is that the text will flow 
continuously and make pages on the fly until all your text 
is placed. Load your cursor, and shift + click (top of box or 
top margin of column/page).
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Text Flow Short 
cuts

Manual Text Flow: 
cmd + d, or File > Place 
Click into the frame. There 
will be a text frame override. 
Click the out port and then 
the input port until finished. 

Semi-auto Text Flow: 
Cmd + Click the text frame. 
The cursor will be loaded, 
so you can click whatever 
frame you want until the 
copy has all been placed.

Auto Text Flow:  
Two options–Create a 
master text frame (adjust in 
master) or set up columns 
during page set up. Shft 
+ click at the top of the 
margin to have text flow in 
the columns or shft + click 
inside threaded text frame 
to have it flow and add 
pages automatically.

The file on the top left (Fig. 6.1) has no text boxes; only 
columns set up when the document was created.

The file on the top right (Fig 6.2) has master text boxes 
set up when the document was created. The master text 
box assumes the properties of the columns you specify, 
therefore, the text frame itself is divided into columns and 
it sits on top of the column guides.

The file on the lower left (Fig 6.3) has columns made  
using “create guides.” They will not automatically flow 
copy. You need to create text frames (in the master) 
and link them yourself. See the master page spread to 
understand completely.

Fig 6.1 Fig 6.2

Fig 6.3

Select all three of these files and open at the same time 
(Demo Files > Flowing Copy). They will open in the view 
below. The cursor is loaded and ready to go.
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fOnT fORMATS & TERMInOlOgy
 When trying to identity formats in folders, it is best to use 
a font manager. The icons in the folders can really confuse 
you because Mac TrueType font files and Mac PostScript 
suitcases have the same icons. Note also, that a TrueType 
Suitcase is one file, and a PostScript font has two files: the 
suitcase and the outline file. The term “suitcase” indicates 
nested styles in one family. It does NOT mean one file.

To make things more confusing, A Mac TrueType will NOT 
work on a PC, whereas a PC Truetype font will work on a 
Mac. The PC truetype font is distinguished on a Mac by the 
TTF icon. In a PC, the icon is two T’s. A Mac TrueType has 
no extension. 

Type 1 Fonts (or PostScript Fonts) 
The important thing to remember about Type 1 fonts is 
that there are two files associated with one font (3 files for 
a PC trueType). There is the part containing all the screen 
information, and then there is the part that contains the 
printer information (outline). These fonts have been the 
industry standard for output devices as TrueType often have 
problems with a RIP system. The bad thing about them, is 
that the two parts often get separated, and the font becomes 
unusable. It is easy to see how this might happen. When 
fonts are collected or packaged, they are not paired up in 
folders, but loose in the fonts folder.

Another important thing to know is that Type 1 Mac fonts 
do NOT work on a PC, and Windows has its own version of 
PostScript fonts that do NOT work on a Mac. PC Windows 
Type 1 fonts contain 3 separate files of information for that 
one font, so these fonts can easily become corrupt if they 
lose any part of this information. Postscript fonts must 
remain in their folders.

Mac PostScript Type 1 Fonts

+

Sec 7-2: OpenType Fonts 
Now an industry standard, Open Type fonts work on either 
a Mac or PC. There are two types of them, but both work 
on either platform. The PostScript flavor (as opposed to 
the TrueType flavor) is preferred in the printing industry, 
however rumor holds that the ttf version will sustain 
the industry. Currently, the ttf version of .otf is basically 
an improved version of its former self. The Windows 
OpenType extension is .ttf, but the icon in an “o.” The Mac 
version is the newly-created format. It has a .otf extension.

The beauty of OpenType fonts, is that an open type has all 
of its information in one file—like TrueType—so you can’t 
lose parts of it. They are cross platform. Another wonderful 
thing, is that there is so much information in them. It 
may have multiple languages ligatures, fractions, ordinals, 
alternates, and more. These are expensive fonts. The Adobe 
Creative Suite contains all OpenType fonts.

Sec 7-3: dfonts (Data Fork Fonts)
“.dfonts” are system fonts and should not be used for output 
devices. Lynda.com recommends creating a different format 
from this font using a font editor. FontLab or Fontographer 
will fix font with missing files, and to convert fonts to 
alternate formats.
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Multiple Master Fonts 
Multiple Master fonts are PostScript Type 1 
fonts that should not be used. This format was 
abandoned when it was apparent there were 
problems with the format and the OpenType 
format was in development. This format contains a 
huge list of styles, and causes problems with output 
processing. Convert these MM fonts to another 
format using a font editing program.

Formats Summary
In conclusion, try to use OpenType fonts when you 
have a choice. Quark 6.5 does not offer .otf support 
but 7 does. Secondarily, use PostScript Type 1 
fonts, although these will be phased out with new 
operating systems. Sometimes when packaging, 
PostScript fonts are not complete, so it is a good 
idea to check to make sure the fonts are complete 
after you package.

Working with OpenType Fonts
Features available with OpenType (or “Pro”) fonts 
are very useful when working with proper fractions 
(Figure 7.1) using proper old style numerals 
(Figure 7.2) ligatures, and small caps. You can 
use “glyph shifting” on all caps type rather than 
manually adjusting. The Helvetica Neue LT doesn’t 
have this feature, as it is not a pro font. The pro 
font family currently sells for $1,300; the standard 
.otf family is $862. To see pro features, see faces 
such as Caflisch or Bickham Script (Figure 7.3).

Fig 7.1

Fig 7.2

Fig 7.3

Note: ClearType is a font format developed by Microsoft for 
Windows Vista. These fonts were developed for readability 
on the screen. It will be nice when this technology can be 
standard for all web browsers.

Type design moves at the 
pace of the most conser-
vative reader. The good 
type-designer therefore 
realizes that, for a new fount 
to be successful, it has to be 
so good that only very few 
recognize its novelty.

—Stanley Morison
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TyPOgRAPHIC uSAgE
The best way to select complimentary faces is to understand 
the typeface designs. Some general knowledge (or a 
refresher) about typeface anatomy will make your decisions 
easier and more enjoyable. When using a typeface you 
are unfamiliar with, research its history and denotative 
qualities. Understand your audience and know what they 
are comfortable with. Most importantly, layout some pages 
with a few different type combinations. Add a sample 
of your colors, graphics, and any other pertinent design 
feature and get opinions.

Selecting Complimentary Typefaces 
A short discussion about how to choose complimentary 
typefaces can help you to make better typeface decisions 
following a couple very simple rules. Please refer to a guide 
or reference for further information. Fig. 8.1 may help re-
familiarize you with type anatomy.

In general, a layout will contain two complimentary 
copy typefaces. Witihout two faces a layout can be as 
monotonous as using only one grid structure. Display type 
may be a second typeface or a possible third. One of these 
typeface choices may be for your headlines or subheads and 
to create emphasis in your layout, and the other face can be 
used for copy that is appropriate for ease of reading. These 
two typefaces should work together and aid the reader 
throughout your layout. 

The basic rules for this are as follows:

Choose a serif and a sans serif for contrast: 1. The 
typefaces should have basic characteristics in common  
X-height characteristic is a main property to compare, and 
set width of the faces is secondary in importance  

The faces should look different enough to be easily 2  
distinguished, however they should not be so different 
that they are a distraction  Note: a display face is an 
appropriate distraction 

Other typeface considerations are: typeface 3  
classification (don’t mix a classic Old Style face with a 
contemporary swiss style) contrast of thick-to-thin strokes, 
match typefaces with the same connotations (mood, idea, 
message, or resonance)  Stress (angle of the letter) is an 
important consideration  Old classifications will have a lot 
of stress, while the moderns and Neo-grotesques will have 
a vertical stress 

Body copy should not be noticeable, and the focus should 
be readability. Display faces, however, should be very 
noticeable. This will set the creative tone for your layout. 
Typefaces (i.e. Papyrus) will give the layout an organic feel, 
and faces like Eurostyle will give your layout a mechanical 
look. Other display faces can be distressed, cartooned, 
script, poster faces, deco, pop, blackletter, and lots more. 
Choose according to the message of your layout. 

Fig. 8.1
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Some typefaces that might compliment 
Helvetica:

Working with Helvetica Neue
One of the most neutral faces designed is Helvetica. 
It is a classic in its almost invisible qualities. It can be 
unnoticeable or very recognizable. It fits every mood, every 
situation, and can be used in just about any layout. Created 
in 1957 by Max Miedinger to compete with Akzidenz 
Grotesque, it is a very marketable typeface, however where 
Akzidenz may seem awkward, Helvetica shines. 

Most typefaces are designed with more letter spacing than 
Helvetica, and it is very common to track in or reduce the 
space between letters for headlines. Some of Helvetica’s 
design features also need to be adjusted depending on your 
layouts. The letters of Helvetica are designed to be very 
tight. This may seem a bit awkward in some situations, 
however it is great for headlines. In the Trainspotting 
poster, you can see the letters have been tracked out, and 
still the “tti” seems a bit tight. Body copy at small sizes 

may need to be tracked about 15 units, and 
headlines perhaps a little bit. Word spacing 
seems somewhat large considering such a 
tight set, so you may want to reduce the space 
between words also. You may want to consider 
the tracking as a standard when setting up 
your “basic paragraph” default, and/or in your 
set of established styles.

See the attached file: helvetica.pdf 

Note: When Helvetica’s stroke is 
reduced to slightly visible, you 
can see the detail that emerges 
in its design.

Helvetica
Helvetica

45 light

55 roman
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REVERSED TyPE & blACk On blACk
Reversed type is a concern of readability. We spend a lot  
of time designing so our reader will fly through our layouts 
smoothly and then expect them to flow through barely 
legible copy. Of course, reversing type (when type color  
is lighter than the background) is a situation where the 
rules often apply to particular typefaces. There are some 
general considerations. 

Reversed Type
As a general rule, don’t reverse type on less than 40% 1  

gray background  This value may change according to 

color  Compare your color screen value to a value of black  
Other screens may be acceptable, but it depends on the 
importance of readability in your document  You should 
also consider the needs of the target audience 

When reversing type, avoid high contrast typefaces like 2  
moderns (Bodoni or Didot)  If you must use a serif, use one 

that has relatively even stroke weight such as Baskerville  
or Caslon 

Do not use a “light” style in reversed type if possible  3  
The background will eat up the white visually, and when it 
prints, there will be a certain amount of dot gain that will 
eat up more of your white space 

Open up the tracking by 10 or 20 (1/1000 em) to give 4  
the letters some room around them for easier identification  

You can see how legibility is severely affected (above) 
using the high contrast font. The Helvetica 45 light with 30 
tracking is acceptable, but the Helvetica Neue 55 is the most 
legible. If you are going to use reversed type for a large area 
of your layout, you must be very careful to follow the rules 
and experiment to create the most legible situation.

40% Magenta 63% Magenta
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Type on a Gray Background
The general rule for black on black is not to have black  
type on any value of gray over 50%. 

The opposite rule applies in regard to style weight.  
Because there is a lot of ink, you should lighten up the  
font and be sure to open up the area around the letters.  
Dot gain is not an issue as with reversed type. Again, a  
high contrast typeface such as Didot and Bodoni are 
difficult to read on a colored background also, therefore  
if you must use them, pay special attention to their 
readability and open them up.

Sec 9-2:

Type well used is invisible 
as type, just as the perfect 
talking voice is the unnoticed 
vehicle for the transmission 
of words, ideas.

—Beatrice Warde

The better solution would 
be to use reversed type like 
this. It is also better to use 
a sans serif face rather than 
this serifed Minion. 

Black type on 50% gray
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MISCEllAnEOuS DTP RulES
Covering general desktop publishing rules is the focus  
of this section. Basic rules to create good layouts are  
important to know, i.e., reversing type, line measure, 
leading rules, indenting rules, etc. There are many more 
than what is mentioned here, but these are some basic 
underlying layout features defining thoughtful and 
mature layouts. 

Adjusting Headlines
Because headlines demand so much attention, it is 
necessary to set the type to draw attention to the elements 
in a headline that deserve attention. Too much punctuation, 
misaligned punctuation, poor tracking, and improper 
sizes create a barrier to readability. View the attached 
file headlineAdjusting.pdf to see an example of an edited 
headline. It is also important to note that any punctuation 
or imbalanced justification of letters at the beginning of 
the headline or should be hung into the margin to create an 
even left margin. How to hang punctuation or letters (see 
also “headlineAdjusting.indd”):

At the beginning of the headline, before the first letter, 1  
type a space 

Position your cursor to the left of that space2  

In the kerning area, enter a value of approximately -500, 3  
and adjust accordingly  

There is a feature, Optical Margin Alignment, under the 
main menu under Type > Story, that will enable automatic 
hanging into the margin for an entire paragraph. You would 
use this feature for fine tuning your type mostly to balance 
the left margin. If you are working hard to create a nice rag, 

then this is worth considering. It will also hang punctuation 
and hyphens into the right margin.

Sec 10-2: Aligning Punctuation in Caps
When using all-caps type, especially in a high-visibility 
headline, you will need to baseline shift punctuation up to 
align with the middle of the type. Also, punctuation in a 
headline will generally need to be sized down to decrease its 
barrier to readability. Note: The instructions for this are in 
the attached file CapsPunct.pdf

Sec 10-3: Line Measure and  
Leading Rules
Tracking can be a problem with line lengths that are too 
long or too short; or have too little or too much leading. A 
general rule of thumb is to aim for 12 or 13 words per line. 
How much leading you use depends on the actual length 
of the line. If you have large type, your line will generally 
be longer and you should add more leading so the eye can 
track from the end of one line back to the beginning of the 
next line. If you use generous leading as a design option, 
it should be used for short blocks of copy, such as sidebars 
or long quotes. When composing a letter with one column, 
make the measure as short as you can.

Note: An orphan is the beginning line of a paragraph by 
itself at the bottom of the page or column. A widow is the 
last line of a paragraph at the top of a page or column. 
Both of these relate to paragraphs, and don’t relate to line 
length. Orphans and widows can be resolved using the 
“keep option” in your styles options. Keep 2 lines together 
(or more) will keep at least two lines together. “Keep next,” 
will keep headlines with their paragraphs. Less than seven 

The rules of ‘never’ 
(often fervently 
disputed)

NEVER:

combine a first line indent 
and use a space after 
together

indent the first paragraph

use all caps for any body 
copy of length

widely track lowercase 
letters (except for a logo 
or design feature). 

use script in all caps (MS 
Word user giveaway)

insert two spaces after  
a period

place two hard returns 
after a paragraph

underline  
(rules are not underlines)

place a full stop at the end 
of an incomplete sentence 
in a bulleted list

place a semi-colon or 
comma at the end of a line 
in a list
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letters in a line is called a “runt” (Adobe Press). These must 
be resolved manually.

Sec 10-4: Proper Bullets  
(vs. ‘Indent to here’)
Proper bullets (setting them up so they can be saved to a 
style) are preferred because they can be saved as a style. The 
numbered instructions on these pages, are a style called 
“numbered indented.” These are set up the same as bullets, 
and are fully editable in the style. Another advantage of the 
style use, is that you can choose what symbol you would like 
to use for the bullet. Using option + 8 to create a manual 
glyph bullet may be acceptable for some situations (as well 
as an “indent to here”) such as short documents that will 
have little editing.

With your paragraphs selected, from the fly out menu 1  
on the control bar, choose “bullets and numbering ”

From the drop down choose “bullets” or “numbers ”2  

Choose the glyph you would like to use from “add” or 3  
highlight one shown  

Select a character style or “none ” You can change the 4  
properties of this glyph character by having a character 
style set up beforehand  Bullets for most typefaces require 
reducing a point or two 

The next part is a bit tricky. Be sure to have the preview 
checked so you can adjust accordingly. Because these are 
relative settings, there is trial and error involved. Keep the 
indent and same as the tab, and do not have the first line 
indent (a negative number) outdent beyond the text frame.

Try these settings : 

Left indent, 1p6 (.25 in)•	

First line indent -p9 (-.125 in)•	

Tab, 1p6 (.25 in)•	

You can experiment once you get to this point. Set up 
your paragraph attributes such as point size, font, space after, 
leading, color, etc. A right indent looks nice, also. Save this 
paragraph style. It is a time investment well worth the 
payoff, and you can import the style to other documents.

For indent to here, follow these instructions:

If you wish to have an indent, tab to the desired position 1  
(set a tab stop if necessary)

Create your bullet (option + 8)2  

Tab again (you can also space)3  

Type your copy which will wrap to the next line  Position 4  
your cursor in the upper line before the first letter 

Use the key combo option + \, then all the subsequent 5  
lines will wrap to that position 

If you do not use the shortcut, position your cursor and 6  
go to Type > Insert Special Character > Other > Indent  
to Here 

This is a great feature to use if you have shorter documents 
which you can edit easily.

Sec 10-5: Paragraph Rules
If you want to create art incorporating lines, use the line 
tool; if you want to create editable copy with lines, use a rule 
above or below. A rule can be any width, position, color, or 

Adjust Font Size

Increase by Increment:  
Cmd + Shift + > 

Decrease by Increment:  
Cmd + Shift + < 

(Add Option to the above 
keystrokes to make them 
Increment x 5) 

Adjust Kerning/
Tracking 

Increase by Increment: Op-
tion + right arrow 

Decrease by Increment:  
Option + left arrow 

Increase by Increment x 5: 
Cmd + Option + right arrow 

Decrease by Increment x 5: 
Cmd + Option + left arrow

Adjust Baseline Shift 
Move Up by Increment: Op-
tion + Shift + up arrow 

Move Down by Increment: 
Option + Shift + down 

http://www.adobepress.com
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stroke weight, and can be applied consistently throughout a 
document in a paragraph style. This is a paragraph feature, 
so the properties are set from the paragraph fly out menu:

Type your headline (in this case)

Place your cursor in the headline and go to the fly out  
menu to choose “Paragraph Rules.”

To create a rule below, from the drop down, choose “Rule 
Below.” You can also have a rule above.

The length here is set to “column”

The length here is set to “text”

Using a rule to create lines for a form or questionnaire is 
also a nice touch. Press the return key multiple times.

AfTERTHOugHTS:

Better rags
Prior to good paragraph composer software, creating an 
even rag was a manual job, and a workflow complication. 
Knowing how the paragraph composer works in InDesign 
will allow you to have more control over your rags and will 
create a document that is more editable. There are a few 
options available addressing the issue:

Paragraph Composer is a well-written script which does a 
remarkable job of creating a beautiful rag. In your 
paragraph style under “Justification” have “paragraph 

composer” checked. If you have not created a style for your 
copy, the option is located in the paragraph fly out (drop 
down) in the control bar at the top. Another option is to use 
“single line composer” (same locations) if you are wanting 
to edit the line breaks and not have the paragraph adjust to 
your edits. With this option checked, you can edit each line 
as you wish because the composer will only edit one line at 
a time, rather than evaluate the entire paragraph when you 
make a change.

Balancing Ragged lines (another paragraph feature) should 
be used with caution. It will balance the lines in a paragraph 
very well—too well, in fact, because you may have line 
breaks that cut too far into your line measure.

Balancing by hand runs the risk of poor texture to your 
paragraphs. To get a perfect rag, you must adjust tracking, 
word spacing, and make soft returns that are far from 
editable. This should be a very last minute process and is 
not recommended for long documents that will be edited. 
If you must use many soft returns for line endings (not just 
for widows) when the document has future edits, it is a 
good idea to run a find/change on the soft return to make 
sure you don’t miss any.

Optically aligning the margin is another feature for 
beautiful margin alignment. Select your paragraph, choose 
“Optical Margin Alignment” from the main menu. Choose 
Type > Story. This will hang necessary characters into your 
margins for perfect alignment. Well, almost perfect. You 
may need to adjust the point size occasionally until you get 
the desired result.

A way to avoid using the disruptive soft returns is to add 
(or subtract) a little tracking to the entire paragraph to 
see if the lines break more evenly. Creating a good rag is 
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in direct competition with an evenly textured line of type. 
You are making a compromise to the texture of your page. 
It is wise to consider your audience before making these 
edits. Print page samples and don’t judge by your monitor. 
If readability is an issue, you may want to allow InDesign 
to do its “thing.” If structure and graphic elements are 
important, then you may want to create that perfect rag. 
Be sure to print your samples rather than viewing them on 
screen. A good test for type texture, is to hold the paper up 
to the light, and view the type from the back of the page. 
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FRAUD, SAID EX-ACORN WORKER: 


'I PAID THE PRICE' FOR VOTER REGISTRATION  


FRAUD,’ SAID EX-ACORN WORKER: 


1. Track in your whole line


2. Reduce leading


3. Adjust word spacing if necessary


4. Baseline shift up  punctuation


5. Hang beginning line punctuation


6. Have space around punctuation (kern to open up)


7.  Most typefaces require reducing the size of headline 
punctuation


10-2 Aligning Punctuation in all-caps headlines


Modified


Original








Place your cursor in the paragraph.


Please view the style panels.


Note how the copy to the left has no 
overrides?


Character styles were created and 
applied to the already styled text box.


Based on: 
The subhead (H2) is based on the 
headline (H1) character style. If you 
were to change the color of the 
headline, the subhead would also 
change. The typeface cannot be 
changed because the subhead uses 
a different font. Whatever they have in 
common can be edited and updated.













You will notice that the unadjusted Helvetica Neue is rather clumsy 
compared to the unadjusted Melior, which has a nice, even rhythm.







